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Help & Support
First please read this manual thoroughly (particularly the Troubleshooting
section, if present). If a warranty is applicable, further details can be found in
the Warranty Statement, 0080-STF-00139, available upon request.

Tritech International Ltd can be contacted as follows:

Mail Tritech International Ltd
Peregrine Road
Westhill Business Park
Westhill, Aberdeenshire
AB32 6JL, UK

Telephone ++44(0)1224 744 111

Fax ++44(0)1224 741 771

Email support@tritech.co.uk

Website www.tritech.co.uk

Prior to contacting Tritech International Ltd please ensure that the following
is available:

1. The Serial Numbers of the product and any Tritech International Ltd equipment connected
directly or indirectly to it.

2. Software or firmware revision numbers.

3. A clear fault description.

4. Details of any remedial action implemented.

!
Contamination

If the product has been used in a contaminated or hazardous
environment you must de-contaminate the product and report
any hazards prior to returning the unit for repair. Under no
circumstances should a product be returned that is contaminated
with radioactive material.

The name of the organisation which purchased the system is held on record
at Tritech International Ltd and details of new software or hardware packages
will be announced at regular intervals. This manual may not detail every
aspect of operation and for the latest revision of the manual please refer to
www.tritech.co.uk

Tritech International Ltd can only undertake to provide software support of
systems loaded with the software in accordance with the instructions given in
this manual. It is the customer's responsibility to ensure the compatibility of
any other package they choose to use.
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Warning Symbols
Throughout this manual the following symbols may be used where applicable
to denote any particular hazards or areas which should be given special
attention:

Note

This symbol highlights anything which would be of particular
interest to the reader or provides extra information outside of the
current topic.

Important

When this is shown there is potential to cause harm to the
device due to static discharge. The components should not be
handled without appropriate protection to prevent such a discharge
occurring.

!
Caution

This highlights areas where extra care is needed to ensure that
certain delicate components are not damaged.

!
Warning

DANGER OF INJURY TO SELF OR OTHERS

Where this symbol is present there is a serious risk of injury or
loss of life. Care should be taken to follow the instructions correctly
and also conduct a separate Risk Assessment prior to commencing
work.
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Part I

Specification
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1. Hammerhead Sonar

Dimensions

341

Ø
99

419

Ø
11
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18
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Not to scale, dimensions in mm.

Acoustic

Operating
frequency

675kHz 935kHz

Beamwidth 30° vertical, 0.9° horizontal 20° vertical, 0.6° horizontal
Maximum range 100m 40m
Minimum range 0.4m
Range resolution approx. 7.5mm

Sonar Display

Range selections 2m to 100m
Scan resolutions 0.225°, 0.45°, 0.9°, 1.8°
Continuous 360° Yes
Offset sector scan Yes
Attitude
information

Angle of sonar body to vertical (2 axes)

Heading
information

Sonar heading with transducer in straight ahead position
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Electrical and Communication

Operating voltage 20 - 72V DC
Power requirement 30W
Communication
protocol

RS232
RS485
ARCNET

Connector options Tritech 6-pin standard
Others available on request

Physical

Weight in air 6.8kg
Weight in water 3.8kg
Depth rating 700m standard

4000m optional
Materials Aluminium alloy (hard anodised)
Operating
temperature

-10 to 35°C

Storage temperature -20 to 50°C



SeaKing Site Survey System

0672-SOM-00001, Issue 07 11 © Tritech International Ltd.

2. Hammerhead Interface Box

Dimensions

Not to scale, dimensions in mm.

280

17
0

20
8

91

Physical

Weight 2.74kg
IP67 Rating The Interface Box is sealed against dust and

moisture ingress to IP67 standard

Electrical and Communication

Ports AC Power, DC Power, USB PC connection, Sonar
connection

DC Power draw (idle) 3W
DC Power draw (load) 42W
AC Power draw (idle) 17W at 240V AC
AC Power draw (load) 46W at 240V AC
DC Input Voltage 12-36V
AC Input Voltage 100-240V (50-60Hz)
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!
Warning

If operating on 240V AC mains supply (or equivalent from a
generator) the Interface Box must not be exposed to water.
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3. Hammerhead Cable Reel

44
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55
4
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29
5

260375
Not to scale, dimensions in mm.

Weight of 100m
reel

~13kg

Weight of 150m
reel

~16kg

Weight of 200m
reel

~20kg

Weight of reel approx. 6kg unladen
Weight of cable approx. 0.07kg per metre
Material Yellow Polyurethane

Aramid (Kevlar) fibre braid
Material
thickness

1.4mm (nominal)

Cable diameter 7mm (nominal)
Minimum bend
radius

150mm
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4. Hammerhead Tripod

All dimensions in mm, not to scale

Dimensions are in millimetres.

Weight of tripod in air ~9.6kg
Weight of tripod in water ~8.4kg
Material Stainless Steel
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5. MicronNav Transponder (Optional)

Dimensions

79

Ø50

56

68

Ø56

Not to scale, dimensions in mm.

Physical Properties

Weight in air 225g
Weight in water 70g
Length 76mm
Diameter 56mm
Depth Rating 750m

Acoustic Properties

Beamwidth Omni-directional
Transmitter
Source

169dB re 1μPa at 1m
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Electrical and Communications

Power
Requirement

12 - 48V DC

Power
Consumption

3.5W transmitting, 0.28W standby

Data
Communications

RS232 or RS485
(in Responder mode)



SeaKing Site Survey System

0672-SOM-00001, Issue 07 17 © Tritech International Ltd.

Part II

Hammerhead Installation
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6. Hardware Installation
If the unit has been bought with the optional tripod arrangement it will come
supplied with all the necessary fittings to enable the Hammerhead unit to
be mounted. For a guide on the assembly of the tripod unit please see
Appendix B, Assembly of Hammerhead Tripod.

The Hammerhead is supplied with a waterblock and connector with a length
of polyurethane jacketed cable. If an alternative connector is utilised, a cable
may not be supplied and a suitable connector will need to be obtained
separately for system integration.

The waterblock is fastened to the connector endcap and provides a 4000m
rated pressure bulkhead. This will protect the electronics from water ingress
in case the connector is damaged or not fitted correctly. It is not necessary
to remove the waterblock when removing the connector. Whenever the
connector is removed, blanking plugs should be used to prevent ingress of
dirt or moisture to the waterblock.

For mounting on an ROV the head should be secured by clamping on the
cylindrical body section such that the transducer head is unimpeded and
unshielded. The clamp should be applied centrally to the metal body tube and
should not be over-tightened.

!
Caution

It is recommended that a substantial guard is fitted to the ROV over
the scanning head to protect from impact damage. Care should
also be taken to ensure the transducer head can rotate freely and
will not be snagged by any trailing cables.
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7. Mounting

Optimal Orientation
If using with the Tritech International Ltd tripod arrangement the unit is self-
levelling to a maximum of 15°. Ensure that the Hammerhead is mounted with
the transducer at the bottom.

For ROV installation always mount the Hammerhead so that it is as close to
the true vertical as possible in relation to the trim position of the vehicle. The
front filling plug and red LED should be aligned with the natural direction of
travel of the vehicle. Errors in the head alignment can give rise to unreliable
results.

Mounting Material and Suitable Brackets

!
Caution

Avoid any metal alloys containing copper such as brass or bronze.

Non-metallic clamps should always be used where possible to prolong the
life of the unit and prevent any galvanic corrosion effects. If metallic clamps
are used they should be electrically insulated from the sonar body by means
of rubber or plastic strips or mount brackets of at least 3mm thickness and
extending at least 3mm beyond the clamp boundary. They should also be
painted or lacquered with at least three coatings.
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8. Electrical and Communications

8.1. Power Requirements

The Hammerhead unit will typically draw 30W of power and requires a
regulated DC voltage supply of between 20-72V. The optional Hammerhead
Interface Box also provides power to the unit as well as a communication link.

!
Caution

Do not attempt to run at higher voltages to compensate for longer
cable lengths. This will also increase the current and potentially
damage the sonar head.

8.2. Communication Link

The Hammerhead is normally connected using an RS485 serial link which
can be achieved by connecting to the serial port of an SCU, using an RS485
to USB converter or using the optional Hammerhead Interface Box which will
provide a USB output to the PC or laptop.

As a single device the Hammerhead will communicate with AutoComms
technology which is an automatic setup so there is no requirement to
dismantle the unit or manually set any of the communications settings. Set
the desired communications protocols in software and the Hammerhead unit
will automatically update itself to match.

Note

The AutoComms feature will only work with newer versions of
Seanet Pro, so make sure you have the latest version installed.

Note

For AutoComms to function the correct wiring must first be in place
and connected prior to applying power.
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8.3. Networking

Note

To network the devices, AutoComms will have to be disabled and
the communications settings manually selected. Please see the
Appendix F, Networking and communication for more information.

The Hammerhead may form part of a network of sensors using the ARCNET
protocol. This would normally be interfaced through a Surface Control Unit
(SCU) or using a SeaHub device (for detailed setup information please refer
to the appropriate SCU or SeaHub manual). Normal communication with the
sonar head requires a good quality balanced twisted pair cable.

For mounting on an ROV an optional 4000m pressure rated junction box is
also available to provide an RS232 interface to the network of Hammerhead
or SeaKing ARCNET devices. Please contact Tritech International Ltd
customer support or visit www.tritech.co.uk for details of the sub-sea junction
box.

8.4. Pin-out Diagrams

8.4.1. Waterblock Pin-out Diagram

1

4
62

3 5

Figure 8.1. Tritech
Waterblock

Pin MAIN port AUX port Cable
colour

1 RS232 TX
ARCNET A
RS485 A

RS232 RX
ARCNET A
RS485 A

Yellow

2 RS232 Rx
ARCNET B
RS485 B

RS232 TX
ARCNET B
RS485 B

Blue

3 +DC Power Red
4 -DC Power Black
5 RS232 Ground Green
6 Earth/cable shield cable screen
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8.4.2. Burton Pin-out Diagram

5 64
1 2 3

7 8

Figure 8.2. Burton
550-1508

Pin MAIN port AUX port Cable
colour

1 RS232 TX
ARCNET A
RS485 A

RS232 RX
ARCNET A
RS485 A

Yellow

2 RS232 Rx
ARCNET B
RS485 B

RS232 TX
ARCNET B
RS485 B

Blue

3 +DC Power Red
4 -DC Power Black
5 RS232 Ground Green
6 Earth/cable shield cable screen
7 Not connected
8 Not connected

8.5. Cable Termination and Limits
Note

Termination resistors are only required for ARCNET
communication - a single Hammerhead unit operating on the
standard RS485 serial protocol will not need any termination
resistors fitted. For detailed ARCNET setup information see
Appendix E, ARCNET Termination.
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9. Software Installation
Note

For the latest version of the Tritech International Ltd software
packages please visit: www.tritech.co.uk

The Seanet Pro software will be provided either on an installation CD (for
Hammerhead Interface Box to PC) or pre-installed on the Seanet SCU.

For the CD installation, if Setup does not automatically start on disk insertion,
run the SETUP.EXE file from the disk to start the installation. If you need to
reinstall the software, this can be accomplished through the normal Windows
software removal application.

From the installation main screen it is possible to select the installation of
either the Seanet Pro software or the Sonar Image Tiler application.

For more information on installation and operation of the software please see
the Seanet Pro Software Manual which is available from www.tritech.co.uk
and is pre-installed with Seanet Pro as the interactive "help" feature.
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Part III

Hammerhead Deployment
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10. Prior to Deployment
On completion of the installation of the sonar, it can be tested in air by
powering up the system, entering the "Single Sonar" application of Seanet Pro
and observing that the red LED flashes once per revolution of the transducer
as it passes the straight ahead position.

Connection to the computer which is to be used should enable confirmation
that the signal is being sent and received as desired, however, until the unit
is submerged the sonar display will be meaningless.

!
Warning

The Sonar should not be run in air for any longer than 5 minutes for
testing. Operating the unit in air for extended periods may damage
the unit.

Bench Testing
If testing the Hammerhead in air prior to use it is recommended to utilise the
tripod to support the unit while undertaking the test. Alternatively, if testing on
a bench or worktop it is essential that the transducer head is free to rotate.

The Hammerhead should be placed as follows:
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11. Deployment
If using the tripod arrangement for deploying over the side of a vessel or
dockside it is important to check that the path into the water is clear and
free from obstacles prior to lowering over the side. Care should also be
taken to ensure that sufficient cable length is available and that there are no
snags in the cable. If a Kevlar reinforced cable and arrest system has been
purchased then the device can be raised/lowered using the cable, however,
it is recommended that a rope or chain is used to prevent the possibility of
damage from the cable snapping.

!
Warning

A minimum of two people should be employed to deploy and
retrieve the Hammerhead and tripod and both should be equipped
with life-vests.

Step 1

Two people should bring the tripod
to the waters edge, holding the legs
securely.

Ensure cable
is not entangled

Rest 2 legs
on the dock
or boat side

Plan view Side view

Step 2

Lower the legs over the side of the
boat or dock until the rope at the top
is easy to grasp.

Step 3

Take a firm grasp of the rope and
lower the rest of the way into the water
- at this point the second person is
not required for lowering and should
instead ensure that the rope is free to
run.



Deployment SeaKing Site Survey System

0672-SOM-00001, Issue 07 27 © Tritech International Ltd.

!
Caution

Do not attempt to lower the tripod using the data cable unless it
is Kevlar reinforced and fitted with an arrest system, otherwise it
could break or cause damage to the waterblock or connector. If in
doubt use a rope attached to the tripod.

Once the tripod has been lowered into the water it is important to ensure that
the device is sitting level, while small variations in the seabed can be corrected
by the gimbal arrangement of the tripod, any variation greater than 15° in any
direction will result in incorrect images on the sonar display. Attitude can be
checked using the built-in sensor which is displayed on the main Seanet Pro
screen.

Tripod not level and
beyond the 15° range of
the gimbal - will result

in incorrect images and
will have to be moved

to a new location.

Tripod not level but
Hammerhead has
self-levelled due to
the gimbal feature.

The perfect scenario
where tripod is lowered

onto a level seabed.
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12. Retrieval
On retrieval of the system it may become snagged with ropes, seaweed or
other debris as it is being drawn out of the water. It is advisable to have a
boat-hook or other device available to free the tripod legs and enable easy
retrieval.

Pulling to retrieve tripod

The tripod legs are likely to catch
and drag on harbour side so

any chains, etc., will be caught
on the leg - free these with a

boat-hook or similar to prevent
excess weight on retrieval rope

The unit should then be washed down and stored in accordance to the
instructions in Chapter 25, During Regular Use.



SeaKing Site Survey System

0672-SOM-00001, Issue 07 29 © Tritech International Ltd.

Part IV

MicronNav Transponder
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13. Overview
The MicronNav Transponder is an optional part of the system that is
purchased separately as a part of the MicronNav System. Please contact
Tritech International Ltd for more details and refer to the MicronNav System
manual for a complete guide on the installation and set up of the MicronNav
equipment.

This section details only those aspects of operation and installation that
are specific to the SeaKing Survey System and for the sake of brevity it is
necessary to leave out many details. Any information which is missing from
this manual will be captured in other documents, all of which are available
from www.tritech.co.uk.
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14. Transponder Installation

Mounting to the Tripod

The MicronNav Transponder is designed to fit into a black acetal housing
which is screwed onto the Hammerhead tripod, this housing is normally
supplied with the tripod.

To attach the MicronNav mount first locate the correct hole on the top plate
of the tripod. The correct hole is the one which is away from the gimbal ring
locking bolts.

Once the correct
hole has been
located, hold the
bottom part of the
MicronNav mount
underneath the
tripod top plate:

Next place the
top section of the
MicronNav mount
onto the bottom
section and screw
down.



Transponder Installation SeaKing Site Survey System

0672-SOM-00001, Issue 07 32 © Tritech International Ltd.

The completed
installation of the
MicronNav mount
should look like this:

Electrical and Communications
In Transponder mode the MicronNav subsea modem head only requires
power supply connections, all communications are achieved through the
water.

A suitable connection cable should have been supplied with the system and
will be wired as follows:

1
26

4
35

Face View
Connector

MicronNav
Transponder cable end

Pin Wire
Colour

Function

1 Yellow n/c
2 Blue n/c
3 Red +V DC
4 Black 0V
5 Green n/c
6 none screen
n/c = not connected

4

1

5

6 2

3

Hammerhead AUX
port cable end.
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15. Transponder Operation
Once the MicronNav Transducer is correctly installed on the top of the
Hammerhead tripod it will be necessary to configure the rest of the
MicronNav System. It may also be necessary to construct a suitable mounting
arrangement for the MicronNav Dunking Transducer.

Full details of the correct configuration and mounting arrangements can
be found in the MicronNav System Manual (document reference 0656-
SOM-00001).

Seanet Pro Application

If Seanet Pro has not been used with a Hammerhead and
MicronNav before then it will be necessary to set up a new
Seanet Pro Application (Applications menu and then select
Application Wizard). The application should include a Sonar
(for the Hammerhead) and MicronNav (for the Transponder).
Once this Application is set up it will be saved automatically and
subsequently can simply be selected from the Applications
menu.
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Part V

Seanet Pro Software
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16. Hammerhead Software Features
The Seanet Pro software is used to operate the Hammerhead system and a
comprehensive manual for the Seanet Pro software will have been supplied
with the system (in electronic format) and can also be found on the Tritech
International Ltd website. SCU systems generally have an electronic manual
already installed by default.

One unique feature of the Hammerhead Sonar is that it is supplied with two
operating frequencies of 675kHz and 935kHz - the frequency can be switched
by clicking on the number in the main Seanet Pro display or by pressing the
"Freq" button on the RAT (button F5).

The default operation of the Hammerhead version of Seanet Pro software
has other device options removed from the Applications menu but these
can be enabled using the Application Wizard. This is useful if the
Hammerhead is to be used with a MicronNav system or if it were used
alongside other Tritech International Ltd products like a PA500 altimeter on
an ROV.

The Hammerhead device also has the ability to build up a picture of a wide
area as a series of "tiles" which are then stitched together in using the Tritech
Sonar Image Tiler post-processing software.

Using the Hammerhead and MicronNav along with a GPS device and Sonar
Image Tiler software will enable positional recording and charting and can be
used to create a detailed record of wreck sites or harbours.

Note

A line of sight has to be maintained between the MicronNav
Transducer and Transponder at all times and in particularly noisy
environments such as confined or busy harbours the acoustic
positioning may be adversely affected.

The Hammerhead also incorporates an attitude sensor and compass so these
will be displayed by default on the Seanet Pro main screen
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17. Seanet Setup
If a MicronNav System is installed

If a MicronNav Transponder is in use with the survey system it will
be necessary to set up Seanet Pro for use with a MicronNav System
as well, so in addition to the following steps to set up for a single
Hammerhead the procedures within the MicronNav System Manual
(document reference: 0656-SOM-00001) should be followed.

Outline of Procedure

To set up the Seanet Pro system for use with the Hammerhead the following
basic procedure should be followed (these points are expanded below):

1. Connect the Hammerhead Interface Box to the computer via USB (no
external power to the Interface Box is required at this point).

2. Obtain the COM port number which corresponds to the Interface Box.

3. Configure Seanet Setup to use the correct COM port number.

4. Connect the Hammerhead Sonar to the Interface Box.

5. Provide power to the Interface Box and turn on the Sonar Power switch.

6. Verify that the Hammerhead Sonar is displayed in Seanet Setup.

Connecting the Interface Box

If using a single Hammerhead Sonar and the Hammerhead Interface Box and
a default installation of Seanet Pro it will only be necessary to enter Seanet
Setup to select the correct serial COM port as detected by the computer.
The number of this COM port will vary depending on the individual computer
and can be found by navigating to the Windows Control Panel and then
the Device Manager under which there is a drop-down list of COM ports
called Ports (COM & LPT).

When the Hammerhead Interface Box is connected via USB Windows will
automatically assign a COM port to it. If there are several entries in the list the
correct COM port can be identified by monitoring the list and unplugging the
Interface Box, at which point the corresponding port number will disappear
from the list. The Interface Box will be listed as a USB Serial Port.
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Once the COM port number is known start Seanet Setup by clicking on the
desktop icon or through the Start menu. Navigate to the Utilities menu
and select Com Setup.

In the Channel Setup dialog which is now displayed find the entry labeled
Aif (it is the first entry by default) and click on the Enabled check box. Once
the Aif device is enabled, click on the right arrow in the COM Port column to
advance the COM port to the correct value (in the example below Windows
assigned COM21 to the Interface Box). Once the correct value is selected the
Status column will turn green and be labelled "OK" and the Type column
will display "USB".

Connecting the Hammerhead Sonar

Once the Interface Box is correctly configured the SeaKing Hammerhead
Sonar should be connected to the Interface Box and power should be
provided through either the AC or DC inputs on the rear of the Interface Box.

If the power supply is correct the Power Connected LED will illuminate on
the top of the Interface Box and it will now be possible to turn on the sonar by
pressing the Sonar Power button on the front.

After a short delay while the Hammerhead Sonar automatically configures
itself to the correct communications protocols the sonar head will be displayed
in the Seanet Setup dialog box as follows:
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At this point Seanet Setup can be closed and the main Seanet Pro application
can be started.
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18. Seanet Pro Main Functions

18.1. Main Screen
The Seanet Pro application can be run from the Programs group in the
Windows Start menu or from the desktop by double clicking on the shortcut
icon.

The main areas of the display are:

1. Display Header This part of the screen is used for system/software
identification.

2. Menu Bar This is where system set-up functions can be accessed.
Printing, Application selection, Colour Scheme setup and Logging are
some of the features that can be accessed in this screen area.

3. Settings Bar  This is where the Sensor can be controlled and
configured. The Settings bar is on top of every display window for each
device that is connected to the system. It includes a Tools Setup button,
Led indicator (Pause/Go) and RAT dials and buttons

4. Status Bar  This part of the screen is used to display system status
information, typically interface status, logging status/progress and job
specific information.

5. Sensor Display Area This part of the screen is where the main sensor
data is displayed. Other pertinent data such as range scale, cursor and
status messages pertaining to the sensor may also be displayed within this
area.
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6. Sidebar This is where serial input data and custom text can be displayed.
This bar can be placed on the left or right hand side and it can also be
hidden.

18.2. Sonar Settings
These controls are displayed on the Sonar Settings bar. When the RAT is
used or screen cursor is moved over the Sonar Settings bar, a pop-up control
panel will appear which will display the remaining controls. These mimic the
positions of the rotary controls (C1 to C5) and function buttons (F1 to F7) on
the RAT. Adjustments may be made using the RAT or the on screen controls
using the pointer device.

Figure 18.1.

Note

F1, F2 are not applicable in single window applications, F7 is not
used.

Sonar Gain (C1) This sets the sonar receive gain as
required – typically this is around 50% but
is varied according to water and target
conditions and user preference.

Contrast (C2) This sets the display contrast between
hard and soft targets. Usually set to
user preference, it can help find small
features in generally featureless situation
or exclude clutter from a heavily featured
seabed.

Range (C3) This sets the maximum range the sonar
will scan. Long ranges are scanned more
slowly than short ranges due to the limit
imposed by the velocity of sound in water.

Sector Scan Direction (C4) This is used to set the centre of
the scanned sector particularly useful
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when using a narrow sector width to
concentrate on a particular feature. A well
positioned, narrow sector will allow faster
scan updates than a wide sector.

Sector Scan Width (C5) This sets the width of the scanned sector.
Typically this will be adjusted according to
the required seabed coverage.

Display Sensitivity (C6) This sets the display sensitivity threshold.
A low setting will effectively remove
very low level returns from being
displayed which may include (soft)
seabed backscatter whereas a higher
setting will start to remove higher
amplitude echoes which may include
objects of interest. It is normal to keep this
at a low setting of no more than 5dB to
remove low level ‘noise’.

CYC (F1) - Cycle Window This can be used when one of the display
windows is maximised using the Expand
(F2) button and will cycle between the
Sonar display windows. Also use the F1
button to switch focus between the display
windows. The optional RAT controller will
switch its control to the display that has
the focus. Note: clicking on a display with
the mouse pointer will also switch focus to
that display.

EXP (F2) - Expand Window This will maximise the current display
window that is in focus. Either click on a
display window to switch focus to it before
expanding, or press the Cycle (F1) button
to switch focus to a display window.

ZOOM (F3) This will toggle the Acoustic Zoom window
on/off. This draws a zoom box on the
display positioned by the cursor. This
control is also toggled via Application
Tools - Acoustic Zoom. The Zoom
window size and magnification can then
be adjusted in ‘Zoom Setup’ in the
Application Tools.

RES (F4) – Sonar Resolution Resolution toggles through preset step
sizes for the sonar scanning. Available
step sizes is dependant on the sonar
being used. Smaller angles give a higher
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resolution picture but slower scan speeds.
Usually a Lo or Med resolution is used for
tracking moving targets and Hi or Ult for
detailed examination of static targets.

FREQ (F5) - Sonar Frequency This toggles between the channels
available on the sonar. For a single
frequency sonar unit this control will be
inactive and will lock to indicate the
operating frequency of the sonar.

REV (F6) - Reverse Scan
Direction

This allows the operator to instantly
reverse the scan direction without waiting
to reach the end of the scanned sector.

Sector Quick Select This group of 5 buttons in the bottom right
of the control allows the user to make a
quick selection of a full 360° scan or 180°
forward, back, left or right. The display
view is changed automatically and the
appropriate sector width and direction set.

18.3. Status Bar

Figure 18.2.

1. Date and time.

2. Status of interface card (AIF card).

3. ARCNET LAN Timeout counter

4. Status of Serial COM port inputs.

5. Status of Remote Access Terminal (RAT).

6. Sensor Status.

Various error codes are reported in the status bar at the bottom of the screen.
These help the user determine any faults with equipment or cabling, as a
guide to making any corrections or replacements

Status and error codes:

No Aif The AIF card is not installed or not configured/
enabled correctly. This status will also appear when
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using the SeaHub serial port interface instead of the
AIF card interface.

Rat Ok Remote Access Terminal (RAT) is connected and
communicating okay.

Rat N/A RAT is not connected or there is a connection
problem.

No COM Will display if only an AIF Card interface is in use
or no COM Port has yet been opened (e.g. No
“Aif” device yet enabled from Com Setup accessed
through the Utilities menu).

Com OK For SeaHub or COM Port interface; A COM port has
been opened and is functioning correctly.

Com Bad For SeaHub or COM Port interface; The COM port
cannot be opened – it may already be in use by
another application or may have a problem.

Com AIF Error TMO For SeaHub or COM Port device interface; the
device is not responding (check it is connected and
powered).

Timeout x There is no communication with head node x

18.4. Main Menu

Figure 18.3.

1. Print Output screenshot to printer.

2. Screen Capture Screen to AVI or save screen to Bitmap/Tiff.

3. Exit Used to exit program.



Seanet Pro Main Functions SeaKing Site Survey System

0672-SOM-00001, Issue 07 44 © Tritech International Ltd.

Figure 18.4.

1. Load/Save Settings Save and Load the current display and device
settings (up to 8 can be saved).

2. Environment Used to enter environmental parameters such as system
Velocity Of Sound.

3. Always On Top Main Screen is Always on Top of Windows desktop.

Figure 18.5.

This Menu Item will only be present in Seanet Pro and not from running
Seanet Setup from the desktop icon. Application examples include Single
Sonar, Sonar Profiler and Sonar Bathy Profiler. There is also an
Application Wizard available at the top of the list which can be used to
create user applications for required device combinations.
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Figure 18.6.

1. GPS Pop-up Form to display GPS data received through a COM port.

2. Compass Pop-up Form to display Compass data received through a COM
port.

3. Auxiliary Device Pop-up Form to display Aux Device data (i.e.
Digiquartz Pressure Sensor or PA/NMEA Altimeter data) received through
a COM port.

4. Com Setup Configure and Enable COM ports for various serial inputs/
devices including GPS, Pipetracker, Barometer and Compass.

5. GPS Diagnostic Terminal window for viewing received serial data.

6. Compass Diagnostic Terminal window for viewing received serial data.

7. Auxiliary Device Diagnostic Terminal window for viewing received
serial data.

8. Barometer Diagnostic Terminal window for viewing received serial
data.

Figure 18.7.

1. Sidebar Enable/Disable the Sidebar. Note: In certain applications, i.e.
‘Sonar Video’, the Sidebar will be opened and docked to the blank ¼
window panel filler.
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2. Toolbars There are several toolbars containing shortcut buttons which
can be displayed in the Menu Bar area or docked to the sides of the Display
Area. For details see the "Toolbar Shortcut Buttons" section.

Figure 18.8.

1. Play Use to play back recorded log data (follow the on screen display).

2. Record Use to record Sonar data (follow the on screen display).

3. Stop Stop recording and/or Auto Logging.

4. Setup Select file options for recording log files (Follow the on screen
display).

Figure 18.9.

Sonar (this will be renamed for other devices, e.g., Sidescan, Profiler,
Bathy)

1. Colours Use to select a saved colour scheme.

2. Colour Setup Use to configure the existing colour scheme or create a
new colour scheme.

Some examples of colour schemes that are available by default:

Figure 18.10.
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Figure 18.11.

Windows (only functional in multi-Sensor Applications)

1. Cycle F1 Cycle to the next Display Window (can also be done using the
F1 key).

2. Zoom F2 Enlarge the current Display Window to fill the window, click again
to display all the Display Windows (can also be done with the F2 key).

3. Sonar Switch focus to Sonar Display window.

4. Sidebar Will be replaced with name of another Sensor in a Multi-Sensor
Application.

Figure 18.12.

The Sound menu enables an acoustic representation of the visuals presented
on the Main Screen of the Seanet Pro application. Clicking on Setup allows
configuration of how this sound is represented.

Figure 18.13.

1. About Seanet Gives details of program and version number.

2. Seanet Guide Seanet Help file.

3. System Information Gives information of computer resources in use.
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18.5. Measurement Tool
By left button clicking and dragging on the Sonar display window (or Acoustic
Zoom window) an elastic band is laid for range and position measuring of
targets.

Dx, Dy = Cartesian co-ordinates of current pointer position relative to Sonar.

Rng, Brg = Polar position of pointer relative to where elastic band was laid.

Note

The range units used are those selected in the Setup menu.

18.6. Toolbar Shortcut Buttons
On the left hand edge of the main Seanet Pro display is a toolbar containing
icons as detailed below:

1. Play Log File Opens a dialog window to enable the
selection of a .V4Log file for playback.

2. Record Log File Starts recording a log file, a dialog box
will present itself so a name can be chosen for the log file.

3. Stop Logging/Playback Halts the current playback or
recording activities.

4. Log File Setup Opens the settings dialog to control how
files are logged.

5. Print Opens the Print dialog to enable selection of an
output printer, paper size, etc.

6. Printer Setup Enables printer settings to be changed.

7. Quick Print If Quick Print is enabled when Print is
selected the dialog box will not appear and instead the
printer will use whatever settings have been specified in
Printer Setup.

8. Sidebar Displays or hides the right-hand sidebar.

9. Start Screen Capture to AVI Starts recording an AVI
file onto disk - note that this does not include an associated
log file.

10.Stop Screen Capture Stops the recording activity.

Figure 18.14.
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11.Screen Capture Settings For changing the settings for
the AVI recording.

12.Snapshot Opens a dialog prompting for a name for either
a Bitmap (.bmp) or TIFF (.tiff) image of the Seanet Pro
display screen.

Right-clicking on a space within the button bar brings up a menu to enable
different types of buttons to be shown/hidden. This is a duplicate of the
Toolbar option located in the View menu.

De-selecting Large Icons is useful if working on a low resolution display.

Figure 18.15.

18.7. Dynamic Range and Sonar Rx Indicator

Figure 18.16.

The dynamic range bar is the A/D sample window (with 64-colour
mapping) for the Sonar receive signal (which extends from 0 to 80dB).

To the right of the dynamic range bar is the Sonar receive signal
strength indicator (Yellow = Average amplitude over scan-line, Red =
Maximum amplitude echo for scan-line).

Normally the sampling window should not need to be adjusted from
its default position (as shown on the left). However, if used properly,
adjusting the sample window can produce better quality imaging.

The dynamic range bar can be adjusted to change Sonar display
contrast and sensitivity. Adjustment is made using the left and right
mouse buttons.

Contrast adjustment Right-click on the bar and whilst
holding down the right button, move
the mouse up/down to increase/
decrease the size of the bar. The
sampling window can be any size
between a range of 9 - 25dB.
Decrease the size of the sampling
window to increase the sonar display
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contrast. Ideally the control should be
set somewhere in the centre of the
allowed range (16 - 18 dB) to give
the best results under most conditions.
Select a high value to reduce the
contrast of the sonar display.

Sensitivity adjustment Left-click on the bar and whilst
holding down the left button, move the
mouse up/down to decrease/increase
the Sensitivity of the Sonar receiver.
Decreasing the Sensitivity will produce
a more saturated display with greater
weak-return content. Increasing the
Sensitivity will omit background noise
and low level returns seen at the
receiver

The sonar receiver will accept a return signal in the region of 0 - 80dB. The
dynamic range controls are used to adjust the position of a sampling window
within the 0-80dB dynamic range band of the receive signal. An idealised
representation of the sample window is shown:

Figure 18.17.

18.8. Colour Setup
This is accessed via Colour Setup which is found in the Sonar menu.
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Note

For other device applications such as Profiler, Bathymetric or
Sidescan, the Sonar menu item will be replaced with Profiler,
Bathymetric, Sidescan as appropriate.

Click on the New button to start a new colour scheme or change the colours
of the current scheme (indicated in the drop-down list, Colour6 in this case).
There are 7 factory preset colour schemes which cannot be altered. If you try
to alter these schemes then a dialog will prompt you to save to a new scheme
if and when you try to save or apply changes.

The various colour boxes can be clicked on to configure a new colour for that
item. The 3 slider bars are used to set the new RGB colour levels for each
item and the Apply button is used to confirm the changes. Clicking on OK
accepts all changes and exits the dialog.

Figure 18.18.
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18.9. Environment Setup

Figure 18.19.

This is accessed by navigating to Environment in the Settings menu.
This is where all the environmental values should be applied for use in various
device applications. Only the Velocity of Sound (V.O.S) will apply for a Sonar
application – the remaining entries are for Bathymetric calculations.

1. V.O.S. System value applied to all acoustic devices to correct plotter
ranges. Applies to Sonar and Profiler and can also be applied in MicronNav
calculations.

2. Density Applied to SK701 Bathymetric (no CT probe) depth calculations.

3. Latitude Applied in the Loc Gravity calculation which is then applied
in Bathymetric depth calculations.

4. Barometer Applied to Bathymetric depth calculations when a Barometer
interface is not used. If Barometer interface is installed then Offset and
Height values should be entered.

18.10. Load/Save Settings
This is where the screen configuration can be saved and previously saved
configurations can be loaded. This is accessed via the Settings menu on the
Menu bar.

Place the mouse pointer over the Load Settings menu item, to bring up a
sub-menu listing all the previously stored configuration settings.

There is a default setting that will always appear in the list and cannot be
deleted. This is the setting to be used for reverting the system back to factory
defaults.
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Figure 18.20.

In addition to the factory default up to 8 different configurations can be saved.
To save the current application and form layout, click on the Save Config
button. A prompt will be displayed to enter the configuration name, with a
default name of "User x" initially given, where "x" is the configuration number.

Figure 18.21.

Click on OK to store the current settings to file, where they can later be loaded
using the Load Settings. Disused configurations can also be deleted
from the Save Configuration form by highlighting the configuration to be
deleted and then selecting Delete Config.

18.11. Log Function
This is accessed via the Log menu on the Menu bar:

With Logging de-activated, click on Play to replay a Log file or click Record
to start recording a new Log file. When a new Log file is opened for recording,
the file name will default to a Date and Time format.

During recording, the Play feature will be locked out and Record option will
be ticked, highlighting a recording is active. During recording the status bar
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(on the bottom of the display) indicates the current log file size. Clicking on
Stop or de-selecting Record will halt recording.

During log file playback, the file details will be displayed in the replay dialog.
The Pause button temporarily halts the log file and Continuous Loop plays
it continuously. There is also a (clock) button to select play back at real time
speed. The slider bar controls the replay speed.

Note

The name of the log file is displayed in the replay dialog caption bar.

Figure 18.22.

Setup allows the directory where log files are to be stored to be changed and
set a maximum file size selected. The time-stamping of saved records can
be in either Local or UTC time.

There is an Auto LogOn option to allow auto logging as soon as the system
starts. There is a check-box to activate this (On/Off) via the Rat 'F7' button.

The user can specify a Base Name or choose a Date/Time format to prefix
the automatically generated file names.

Figure 18.23.
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18.12. Print Function

Figure 18.24.

This is accessed by navigating to the File menu and selecting Print

1. Quick Print On When printing the Print Setup dialog box will not
appear and default printer and its settings are chosen.

2. Setup Printer – Select and setup the Windows Printer.

3. To Printer – Print to Windows Printer. When Quick Print On is set
to Off, a setup dialog will appear allowing the user to select printer and
set options before printing.

!
Caution

Printing may take a few moments during which sonar updates are
suspended. It is therefore not advisable to make printouts during
actual underwater operations unless it is safe to do so.

18.13. GPS Display
This is accessed via the GPS in the Utilities menu.

When enabled, the GPS dialog will be displayed.

Figure 18.25.

1. Latitude or Easting
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2. Longitude or Northing

3. Zone

4. Course Over Ground

5. Speed Over Ground

6. Heading

7. GPS Input is used to select and configure the GPS input messages.

8. Diagnostics flashes green when there is an incoming GPS packet.

The GPS input COM port is configured from Com Setup.

The GPS Setup panel is accessed by clicking on the GPS Input button and
is where the NMEA 0183 message type can be selected.

All position data updates displayed in the GPS panel will be recorded when
the logging function is used to record device data and GPS data.

Figure 18.26.

The GPS Setup panel contains 4 drop-down menus for selecting NMEA
0183 message types for Latitude/Longitude, COG/SOG, Heading and
System Time.

It is possible to set the system time via any of the listed NMEA messages
and this will update the clock within the sensor device. This is used to time
synchronise output data strings to a survey computer or if log data containing
both device and GPS position data is to be post-processed.

The GPS Setup panel includes the option to convert and display the
incoming Lat/Lon positions in Easting/Northing format using a UTM or OSGB
conversion.

There is also facility to select the particular Ellipsoid to apply in the UTM
conversion equation with option to apply a geodetic datum shift. By ticking
the User Defined Datum Shift check-box, an Edit button will appear:
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Figure 18.27.

Clicking on this button will display the User Defined Geodetic Shift
panel where parameters can be entered for the required datum shift.

Figure 18.28.

Once parameters have been entered, press Return to go back to the
previous setup panel.

A terminal window can also be opened to display the incoming GPS data
strings. This is opened by clicking on GPS Diagnostic in the Utilities
menu. The terminal window will appear as follows:

Figure 18.29.

18.14. Aux Device Display
This is accessed via the Utilities menu by clicking on Auxiliary
Device.

When enabled, a pop-up Text Box form will be displayed. This can be used
to display ASCII character data from a serial device up to a maximum of 100
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characters in length and terminated with a <Carriage Return><Line Feed>
(ASCII code 13 followed by code 10).

The Aux Device form can process and display altitude data (in metres),
received through a surface COM port, from a PA or NMEA Altimeter;
Digiquartz pressure data will also be converted to display a depth in metres.
The values entered into the Environment dialog (accessed through the
Settings menu) for density, barometer and local gravity will also be applied
to the calculation of depth.

• Use As Remote Event to send the Aux device data to the Sidescan
Sonar or Sub-Bottom Profiler plotter as a ‘Remote Event’ for annotation.

• View Raw Data to view the raw data string from known devices such as
a PA Altimeter or Digiquartz instead of the Seanet processed string.

All data updates displayed in the Aux Device text panel will be recorded when
the logging function is used to record device data.

The Diagnostic Led flashes green when there is an incoming Aux packet. A
Terminal window can also be opened to display the incoming data strings.
This is opened from the Utilities menu by selecting Auxiliary Device
Diagnostic.
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19. Application Tools
The Application Tools menu can be accessed by right-clicking on the

sonar display or by selecting the Application Tools icon: 

19.1. Cursor
Adds the cursor position panel to the sonar display.

Figure 19.1.

The Polar check box changes the output display co-ordinates from Polar
(Range & Bearing) format if enabled to Cartesian (X, Y) format if unchecked.

19.2. Markers

Figure 19.2.

Adds A and B markers onto the sonar display, the range and bearing to each
marker & separation and relative bearing are shown.

Click on the symbol to deploy on the Marker panel and that marker symbol
will be dropped at the Origin (0, 0) on the Sonar display. Then, pick up the
Marker using the left mouse button and drag it to the position required.

Figure 19.3.
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When both markers are dropped on the display, a line will be drawn which
connects them. The ‘Delta’ Range and Bearing at the bottom of the panel
indicates separation and angle between both Markers.

There are 4 sets of Markers that can be implemented; A-B, C-D, E-F, G-H.
The operation of each set is the same as A-B described above.

19.3. Acoustic Zoom

Figure 19.4.

True Sonar Zoom mode draws a zoom box on the display positioned by
cursor. The sonar will take more samples in the area of the zoom box for
target magnification.

Zoom Setup sets the size and magnification factor of zoom box.

The Size shows the screen zoomed area (red outline) as a percentage of
the Acoustic Zoom display window.

The Factor shows the number of zoomed range bins for each normal range
bin. For instance, a Factor of 4 will take four times the number of samples
within the zoomed area than will be taken outside the zoomed area.

19.4. Zoom Setup

Figure 19.5.

Allows the Acoustic Zoom to be configured by selecting a zoom factor or
percentage size increase.
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19.5. Position

Used to move and size the Sonar PPI display in its display window.

Centre X/Y - Adjust X & Y centre position of the display, Radius - Size the
display.

19.6. Display

Figure 19.6.

Sets up sonar display options.

DispMax – Tick to expand sonar display vertically to fit window. If un-ticked
will expand horizontally.

RngLab – Switch the Range Labels On / Off.

Rng Cross, Rings On, Rings, Grid On - Display Grid line options.

Sector On, Sector – Display a Sector overlay with left and right angular limit
adjustment (in degrees).

Rotation – Rotational offset to correct Sonar heading – (Disabled for Gemini
Sonar).
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19.7. Installation

Figure 19.7.

This configures the location of the Sonar in the real world and enables the
Geo-referencing of sonar targets on the sonar display.

From Fixed Position If there is no GPS input, select this option and input
the Sonar position in Latitude and Longitude co-
ordinates (DegMin or DegMinSec format). A Heading
input will also be applied, else a zero degree heading
is applied. If present it is also possible to set the
fixed position from the USBL or GPS input so that
they can be disconnected and the position will remain
persistent – simply click the appropriate button “Set
Fixed from GPS” or “Set Fixed From USBL”

From GPS Position
Updates

If a GPS input is active, select this option. A Heading
input will also need to be active for the Geo-
referencing to be functional.

From USBL Position
Updates

If a USBL input is active, select this option. A
Heading input will also need to be active for the Geo-
referencing to be functional.

From Marker
Positions

This function requires an application with Sonar
and Nav displays loaded (e.g., by selecting
Settings→Applications→Sonar Nav). The
chart of the Nav display is used to obtain the Marker
position references to be used in this function. If a
Nav chart is not used then the Marker positions must
be manually entered in the Sonar display.
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Offset (GPS Rx to
Sonar)

X and Y position offsets should be entered if there is
any offset between GPS receiver and Sonar (e.g. for
a ship hull mounted system). Or, for an ROV mounted
sonar, if the GPS position updates are the position
of a sub/vehicle then this offset may apply for the
separation between a beacon/transponder and the
sonar.

Heading Use this option to select the source of the heading
data. If using a sonar which contains an internal
heading and compass device or if the compass is
connected to the Aux port of the sonar select Internal/
Aux Compass. If the compass device has been
connected through a COM port on the SCU or PC,
or if a USBL system is in use then select Ship/USBL
Compass. If the sonar is mounted to an ROV and
both the ROV and support vessel have a compass it
is possible to switch to the ROV compass by selecting
Sub/ROV Compass.

Once position and heading data are present, the Cursor display will be
extended to provide position co-ordinates when the mouse cursor is moved
around the sonar plotter.

Note

There must be active sonar data, as well as position and heading
data, for the position co-ordinates to be reported.

19.8. Setup

Figure 19.8.

8 Bit Usually checked. Selects the intensity sampling of
sonar data (4-bit or 8-bit).

No Sens Must be off (grayed out as shown) for normal use
to synchronise angular head alignment.



Application Tools SeaKing Site Survey System

0672-SOM-00001, Issue 07 64 © Tritech International Ltd.

Invert Swaps the display from left to right. Enable if
mounted with Sonar boot down.

Detects Paint the leading edge of strong targets on
the screen (only applicable to certain models of
sonar).

Scrn Lock Locks the number of range bins sampled to the
screen resolution.

Flyback Sets the sector scan to flyback instead of scan
back. Normally off.

Xmit Off This option is not available under normal
operation. It is a diagnostics level tool that will
switch off the Sonar transmitter for test purposes.

Auto Dynamic Range This will auto adjust the Display Contrast and
Sensitivity whilst the Sonar is scanning. Auto
adjustment occurs at the end of each full sonar
scan.

Lockout Sets a minimum range for the Detects (always in
metres).

Bins This is the number of samples taken over the
current scan-line.

Units Select the display range units. Options are Metres,
Feet, Fathoms & Yards.

19.9. Interpolate

Figure 19.9.

Applies interpolation between adjacent samples on the Sonar display. Blends
out contrast and ‘blockiness’ on lower ranges and resolutions.
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19.10. Aux Compass
Selecting Aux Compass will place a compass and pitch/roll display on the
sonar screen. The data which is displayed is taken from the device selected
in the Installation dialog.

Figure 19.10.

Note

The compass and pitch/roll display are never displayed side-by-
side as shown here, their position is at the top/bottom right of
the screen by default but can be changed using the Compass
Settings dialog.

19.11. Compass Settings

Figure 19.11.

The Compass Settings dialog allows configuration of the compass and
pitch/roll sensor display on the main screen. The position can be selected
only if Auto Positioning is first de-selected. Also colour and opacity can
be controlled through this dialog.

If more than one sensor is available for selection this should be performed in
the Installation dialog.
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If an offset is required it can be entered here and the compass can be
corrected for displacement of magnetic against True North.

19.12. Overlay

Figure 19.12.

When enabled, this option can be used to place and size an overlay shape
or outline onto the Sonar display canvas.

Style Select the type of shape from; Circle, Rectangle. Triangle.

Size Set the Width and Height of the shape.

Pos Move the Shape with X, Y position offset from display origin.

Line Width Line width.

Centre On Enable centre marker (+) for the shape.
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20. Sonar Position Geo-referencing from 2
Marker Positions

Note

This function requires an application with Sonar and Nav displays
loaded (e.g., by selecting Settings→Applications→Sonar
Nav). The chart of the Nav display is used to obtain the Marker
position references to be used in this function. If a Nav chart is not
used then the Marker positions must be manually entered in the
Sonar display.

First from Seanet Pro, click on the Sonar Tools menu and open a pair
of Markers (i.e., select Markers and choose A-B, C-D, E-F or G-H). The
Marker pair A-B is opened in this example.

Figure 20.1.

Next, enable both markers as outlined in Figure 20.2, “” below. This will lay
the markers at the center of the Sonar display as shown.
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Figure 20.2.

Left click and drag both markers to the reference points that are to be used.

Figure 20.3.

Then, opening the Sonar Tools again select Installation.
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Figure 20.4.

This will open the Installation dialog. From this dialog select the option
From Marker Positions as the Georeferencing option for the sonar and
ensure th correct marker pair is selected (A and B in this case).

Figure 20.5.

At this stage the marker positions can be manually entered into the edit
boxes (DegMins or DegMinSecs are the two format options available through
clicking on the "cycle" button)

If a Nav chart is loaded then the Marker positions can be set from the chart.
Simply right-click on the chart at the point of each Marker location and select
Set As Marker x Position.
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Figure 20.6.

This will update the Marker position entry in the Installation page as
shown below.

Figure 20.7.

The sonar is now geo-referenced. In the Nav chart the Sonar outline overlay
will be displayed when this Nav feature is enabled.
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Part VI

Image Tiler Software
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21. Installation
The installer file for the Sonar Image Tiler can be found on the Tritech
Software Installation CD or downloaded from: www.tritech.co.uk

Note

The screenshots shown are provided for illustration purposes. The
Tritech Software Installation CD version may differ from that shown
in the following images.

The installation CD will autorun on disc insertion, first select the Seanet Pro
button to open the correct section:

Figure 21.1. Tritech Software Installation Screen

Next, select the Sonar Image Tiler button to begin the software
installation.
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Figure 21.2. Select Sonar Image Tiler

Note

If installing from the Internet an executable file called
ImageTilerSetup.exe will be downloaded. Run this file and
follow the on-screen instructions.

Upon installation a program icon will be created on the Windows desktop and
a Tritech Image Tiler folder will be added to the Windows Start menu.

Figure 21.3. Desktop Icon
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22. Software Functions

22.1. Toolbar

Import chart
Export as image
Save project
Load project
Clear project
Add tile
Delete all tiles
Reset all tiles
Resize tile
Create mosaic
Save mosaic
Zoom in
Fit to screen
Zoom out
Toggle coordinates dialog
Toggle coordinate system dialog
Toggle tile list dialog
Toggle chart
Show markers
Move marker
Pan tool
Erase tool
Area erase tool
Remove tile background
Export area

22.1.1. Project Controls

Import/Create Chart

For creating a blank chart or importing a previously created chart. For more
information on this function please see Section 23.2, “Create the Background
Chart”.
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Export As Image

If an area is selected this button will export the selected area. If no area is
selected the whole chart will be exported.

For details of the supported file format please refer to: Section 24.2, “Saving
Images or Mosaics”.

Note

The markers will be embedded into the image file and if the image
is loaded again it will no longer be able to modify or hide them. If
exporting the image to use again as a chart the markers should first
be hidden (see Section 22.7, “Using Markers”).

Save Project

The first time this is pressed it opens a dialog to name and then save the
current state of the chart, tiles and markers as an XML file. Using this option
allows the project to be loaded later and the markers or tiles moved or hidden.

Subsequent presses of the button will not prompt for a filename and instead
save over the existing project - to save under a different name navigate to the
File menu and select Save Project As....

Note

If the tiles have been moved or rotated away from their original
positions it will no longer be possible to restore them after the
Project has been saved, i.e., the new "original" position which they
will be returned to when they are "reset" will be the position which
they were in when the Save Project button was pressed.

Load Project

For loading a previously saved Project file. The files are only generated by
the Sonar Image Tiler and are in XML format.

For details of the supported file format please refer to: Section 24.3, “Project
Files”.
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Clear Project

Removes any loaded data and clears the workspace. Any unsaved data will
be lost.

22.1.2. Tile Controls

Add Tile

Opens a dialog to load an image tile. Image tiles must be in the correct format
and have an associated world file.

For details of the supported file format please refer to: Section 24.1, “For
Loading Tiles”.

Delete All Tiles

Removes all the tiles from the chart. Any unsaved changes will be lost

Note

To delete a tile individually use the Tile List as detailed in
Section 22.6, “Tile List Dialog”.

Reset All Tiles

Resets all the tiles using the position, orientation and size from when they
were first loaded.

If the tiles were loaded as part of a project then they will be reset to the original
state that they were when the project was saved.

Note

To reset a tile individually use the Tile List as detailed in
Section 22.6, “Tile List Dialog”.
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Resize Tile

Tiles can be resized individually using this tool. When the tool is enabled
each tile will show a thin red outline with anchors at the corners and side
midpoints. The mouse pointer will change to arrows indicating the available
resize direction when it is positioned above the resize points. Click, hold and
drag to resize the tile. The corner anchors maintain aspect ratio while it is
resized whereas the side anchors allow the image to be stretched.

Create Mosaic

This will stitch all the visible tiles together into a single image. If only some of
the tiles are to be included the remaining ones should be hidden from view
using the Tile List as detailed in Section 22.6, “Tile List Dialog”.

Save Mosaic

Saves the newly created mosaic as an image with an accompanying world
file which can then be loaded as a tile for future Projects.

Using the Save Mosaic function has the advantage over Create Mosaic
in that it does not alter the tiles within the project so they can still be modified
if desired. The newly created mosaic is in a completely separate file.

For details of the supported file format please refer to: Section 24.2, “Saving
Images or Mosaics”.

22.1.3. Zoom

The zoom controls allow the user to Zoom In on an area of the screen by
using the button  or by scrolling the mouse wheel forward.

Similarly, zooming out can be accomplished using the Zoom Out button 
or scrolling the mouse wheel backwards.

The view can be reset so as the chart fits into the window by pressing the
Fit To Screen button 
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22.1.4. View/Hide Controls

These controls are the same as those found in the View menu and allow the
different dialogs to be shown or hidden from the workspace.

The background chart can be hidden to allow better viewing of the individual
tiles by selecting the View/Hide Chart button: 

For more detail on the functionality of the dialogs refer to Section 22.5,
“Information Dialogs” and Section 22.6, “Tile List Dialog”.

22.1.5. Markers

Using these buttons the markers can be shown, hidden or moved. For a full
description of the use of markers see Section 22.7, “Using Markers”

22.1.6. Tile Manipulation

Pan Tool

The pan tool is the default operation and allows the current viewpoint to be
moved around by clicking and holding the left mouse button - useful if zoomed
in or using a very large chart.

When this tool is selected and the mouse pointer is hovered over the tile
handles the functionality will change to that of move a single tile or rotate the
tile (depending on where the mouse pointer is located).

Note

This tool does not alter the position of the chart - it simply changes
the visible portion on the screen.

Erase Tool

Note

This action cannot be undone. To restore the original tile the tile
has to be deleted and then added afresh.

This tool allows parts of the sonar tile to be removed manually as if using
an eraser. To remove a section of sonar tile select this tool then click and
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drag the left mouse button over the desired area. When this tool is active the
mouse cursor should change to an eraser.

If multiple tiles are overlapping the erase tool will work on the uppermost tile
only but if a portion is already erased the eraser will start to erase the tile
below as well. To avoid accidentially erasing the wrong tile, it is recommended
that the tiles that are not being worked on are disabled or hidden using the
Tile List (see Section 22.6, “Tile List Dialog”).

Area Erase Tool

Note

This action cannot be undone. To restore the original tile the tile
has to be deleted and then added afresh.

This tool erases polygonal-shaped sections from the sonar image tile. To use
it select the tool then click (and release) on the sonar tile, move the mouse
and click again to add another point (the points will be joined by a red line).
Keep adding points until the desired shape has been constructed and then
double-click to close the area (i.e., the last added point will be joined to the
first point with a straight line). When the area is closed the polygon that is
created will be automatically deleted from the tile and the red outline will also
disappear. While this tool is active the mouse cursor will change to a cross-
hair with polygon shape.

All visible tiles that intersect with the defined polygon will have a section
deleted. To make sure that some tiles are preserved, first hide them from view
- see Section 22.6, “Tile List Dialog”.

Crop Background

Note

This action cannot be undone. To reset the tile, it must be deleted
and added again as if it is new.

To control the amount of sonar data displayed in a tile the automatic
background removal tool uses an intelligent algorithm to determine unwanted
sections and remove them from the tile. Unwanted background pieces are
those that are typically around the edge of the sonar scan and do not add
any detail to the images. In general, acoustic shadows around areas of high
intensity should be kept as they add detail and context to the image.



Software Functions SeaKing Site Survey System

0672-SOM-00001, Issue 07 80 © Tritech International Ltd.

22.1.7. Image Export Area

The Image Export Area selection tool enables restricted areas of the
workspace to be exported to an image file. The mouse pointer will change to
a cross-hair for more accurate selection. To use, simply draw a box around
the area to be exported and then press the Export As Image button ( )

Note

Only when this button is enabled will the selection be used as the
export area, otherwise the entire chart will be used.

22.2. Moving tiles

The Pan Tool button  has to be selected for this function to work.

When the mouse pointer is over the centre of the tile it will change to a hand
icon. Hold down the mouse button to drag the tile and position it correctly.

22.3. Rotating tiles

The Pan Tool button  has to be selected for this function to work.

A tile can be rotated by selecting and moving the rotation lever (see Figure
Figure 22.1, “Rotating the Tile”). The mouse pointer will change to show a
hand with rotation arrows when it is positioned above the end of the lever.
Holding the mouse button down and dragging in a circular motion will rotate
the tile:
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Figure 22.1. Rotating the Tile

The amount of rotation will be displayed in the Tile List panel (which can
be displayed using the View menu and selecting Tile List).

The colour of the rotate handle can be changed by navigating to the Tools
menu and selecting Options

22.4. Mosaic of Tiles

To create a mosaic of tiles it will be necessary to have multiple tiles together
within a single geographic region. It will not be possible to create a mosaic if
the tiles are very far apart, likely as a result of having an incorrect or corrupt
world file which results in their incorrect placement.

Creating a mosaic is a simple process, first arrange the tiles as desired and
hide tiles that are not going to be included in the final mosaic, then press the
mosaic button on the toolbar ( ) which will start the mosaicking process. An
example of this is presented in Figure 22.2, “Mosaicking Tiles”.
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Note

The mosaicking process is irreversible and will result in a new tile
created which cannot be split into the original tiles. To restore the
original tiles they will have to be re-loaded.

Figure 22.2. Mosaicking Tiles

Note

If Save Mosaic is pressed instead the output will not be on the
screen but to a file so a file chooser dialog will present itself.

22.5. Information Dialogs
There are also three information panels accessible from the toolbar or the
View menu: the tile list; mouse position; and the coordinate system used.
Both the tile list and the mouse view display the position of tile centres or
mouse pointer, respectively, using the selected coordinate system.

Coordinate System

The Coordinate System display can be viewed and controlled by selecting
the button  or using the View menu and select Coordinate System
option. This allows the user to choose between using Decimal Degree,
Degrees and Decimal Minutes, Degrees, Minutes and Seconds
and Universal Transverse Mercator (UTM). Selecting one of these
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options automatically updates the display in the both the Mouse Position
and Tile List display panels.

Mouse Coordinates

The Mouse Coordinates display is also controlled from the View menu
and View button collection  . It shows the mouse position in the context of
the chosen coordinate system.

22.6. Tile List Dialog
The Tile List panel can be made visible using the View menu and
selecting the Tile List option.

Alternatively the Tile List can also be viewed using the button: .

Action on Multiple Tiles

By holding down the shift key on the keyboard it is possible to
select multiple tiles in the Tile List and move them up/down the
layers together, show/hide them as a group or delete/reset multiple
tiles in one go.

Saving the tile will only work on one tile at a time.

Layering tiles

Layering the tiles determines the order in which they are displayed, i.e., tile
1 is displayed in front of tile 2. The order can be changed by moving tiles up
and down in this list, either as individual tiles or in groups.

Note

If centre marks or rotation handles obscure one another interaction
will occur using the lowest numbered (corresponding to the
topmost) tile so it may be necessary to re-order the tiles to gain
access to the handles.

Click on the row containing a tile to highlight it and then press either the UP
or DOWN arrow to bring the image forward or backward on the display by
one layer.

Multiple tiles can be moved in one go by selecting each one and holding down
the control key on the keyboard (or by selecting a span using the shift
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key). Once selected the tiles can be dragged as a group by holding down the
mouse button and moving up or down the list to re-order them.

The tiles will be automatically renumbered with the lowest number being the
first one displayed.

The tiles can also be controlled using a menu that is accessible by clicking on
the tile entry in the list with the right mouse button. Using this method the tile
can also be moved immediately to the front or the back of the display stack.

Save Selected Tile

Saving a tile will export it with a new world file so that any changes that have
been made to the position or orientation can be preserved.

Delete Selected Tiles

Deleting a tile will permanently remove it from the display. Any changes made
to it will be lost.

If multiple tiles are selected when this button is pressed they will all be deleted.

Reset Selected Tiles

Resetting a tile changes the tile location, orientation and size to the
coordinates and rotation value contained in the world file that was originally
used to load the tile. Any subsequent movements or rotations that have been
made are lost.

If multiple tiles are selected when this button is pressed they will all be reset.

Note

If a project has been loaded the tile will be reset to the orientation
when the project was loaded. The process of saving the chart and
tiles as a project removes the original tile data so the only way to
restore the original tile would be to delete it and reload it.
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Show/Hide Selected Tiles

Tiles are hidden by de-selecting the check box to left of the tile number.

If multiple tiles are selected when this button is pressed they will all be shown/
hidden.

22.7. Using Markers
The Image Tiler has the ability to import a marker file which has been saved
from Seanet Pro (marker files have the extension ".mrk") or from a CSV text
file (full details of the marker files are in Appendix H, Marker Files).

First create the marker file from the chart in the MicronNav application in
Seanet Pro. Then open the marker file by navigating to Import Marker
File from the Tools menu.

The imported markers will be overlayed on top of the chart:

The positions of the markers is shown next to the location. Markers can be
hidden using the button on the toolbar: .

To move a marker first select the move marker button ( ) and then click on
the marker and drag it to the new location.

Note

If markers are displayed and Export as Image is selected they
will be merged with the background. If the chart is to be used again
it will not be possible to move or remove the markers. For this
functionality the chart should be saved without the markers or with
them hidden. If Save Project is selected the chart, tiles and
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markers are all saved as individual entities and can be interacted
with as normal.
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23. Creating the Mosaic Image

Figure 23.1. Completed Mosaic

A mosaic as shown in Figure Figure 23.1, “Completed Mosaic” can be created
with the Sonar Image Tiler using a background chart, and sonar image tiles
with their associated world files. The user must first set a background to
place the image tiles. This background is called a "chart"; although if an
actual survey chart is not available a blank canvas can be used. There is
also the option to use the first added tile as a reference. All image tiles
and background chart or blank canvas require geo-referencing. This is done
during the creation of the chart by entering Position Co-ordinates for
the top-left corner and a chart Width and Height.

With a background chart in place the sonar image tiles can then be loaded
and any position or rotation corrections made. The entire chart and tiles, or a
selected area, can be exported as an image file and a (separate) world file.

This chapter is organised into sections explaining the process of creating a
mosaic, the tools available to the user, and also exporting an image or saving
the project.

Note

Load Project allows a previously created chart, collection of tiles
and markers to be loaded for further editing or for selecting an area
to be exported as a bitmap.

23.1. Overview of Process
Prior to starting the mosaic process it is necessary to obtain the following:
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• An image with GPS data in an associated world file to use as a background.
Or appropriate GPS coordinates and geographical dimensions sufficient to
encompass all of the sonar image tiles if creating the chart manually.

• A set of sonar image tiles from a Seanet Pro session which include GPS
data in accompanying world files.

Given data already created using Seanet Pro the process for tiling images
into a mosaic is as follows:

1. Create a chart: either from an image, import a previously created chart or
create a blank chart from GPS data.

2. Load sonar image tiles onto the chart.

3. Manipulate the image tiles to the correct position (if required).

4. Either export the resulting mosaic as a bitmap (with world data) or save as
a project (containing a chart and a collection of tiles) to work on again later.

23.2. Create the Background Chart
The Sonar Image Tiler starts with a blank screen:

First create a chart background onto which the sonar image tiles will be
placed. If Seanet Pro is running on the PC and has a chart configured as part
of its Nav application then you can select it using the Files menu and Open
Seanet Chart option. If no Seanet chart is available click on the Import/
Create Chart button  to set up a new chart background.

Note

It is also possible to use the first tile as the chart background - see
below for the procedure for adding tiles. This tile cannot be moved
or rotated and acts as the fixed reference point for other tiles.

In the Add Chart dialog box there are three options for adding or creating a
chart. The user can select to use an image with associated world file; an image
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with manually entered position and scale; or a blank chart with manually
entered position data. These options are explained further in the following
sections.

23.2.1. Image with World File

Select Import World File for the Open World File dialog and select
the appropriate world file. The format of the world file can be either .bpw
(bitmap), .jgw (jpeg), .tfw (tiff) or .wld (generic/CAD).

The world file format for x and y co-ordinates can either be in Eastings/
Northings (E/N) or Longitude/Latitude (L/L). If co-ordinates are in E/N then
a Zone will need to be entered and a reference Ellipsoid selected (for
definition of latitude, longitude and elevation).

Verify chart parameters are correct and click OK to confirm and load this chart
onto the display.
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23.2.2. Image with Manual Positional Data

First, select Open Image button to bring up the Open Chart dialog
and select the required chart image. The image format can either be .bmp
(bitmap), .jpg (jpeg) or .tif (tiff).

Note

Where an associated world file (matching name) is detected in
the same folder as the selected image the chart parameters will
automatically be loaded.
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Next, enter the Point of Origin co-ordinates and the chart Dimensions.
If the Universal Transverse Mercator (UTM) coordinate system is used a
reference Ellipsoid will also have to be selected at this point (the default
is WGS84 (World Geodetic System 1984)).

23.2.3. Blank Chart

Select Use Blank to create a blank image for the chart background. A default
width and height will be set.

The Point of Origin co-ordinates and the chart Dimensions will have
to be set. If UTM then also select a reference Ellipsoid at this point (the
default is WGS84).

23.2.4. Co-ordinate System

When creating charts the Point of Origin co-ordinates will be in the
format that is currently selected in the Coordinate System panel. To
change this select Cancel and navigate to the Coordinate System control
(if this is not visible go to the View menu and select Coordinate System).
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23.3. Add Image Tiles

Once the chart background has been loaded sonar image tiles can be added.
Tiles must be within the same geographic area of the chart background.

Either click on the Add Tile icon,  or add the tile through the Tools menu
and Add Tile option.

• A dialog enabling searching and adding of images is shown. The images
can be in .bmp (bitmap), .jpg (jpeg) or .tif (tiff) formats. A matching world
file is required in the same folder or the image will not load.

• The tile will be added on top of the chart if the geographic co-ordinates are
within the background area.

• Simply repeat these steps to add further tiles.

Note

Several files can be added at the same time by holding down the
Ctrl key whilst selecting the images.

23.4. Manipulate Image Tiles

The position information for tiles is dependent on the settings when the tile
scans were created.

If the imported position is incorrect the tiles can be repositioned on the chart
at any point after they have been added to provide a more accurate mosaic.
There are several repositioning functions available: moving, rotating, and
resizing. As well as tools to alter the appearance of shadows in tiles: automatic
cropping of unwanted shadows, manual eraser, and area erase.

For full details of the possible ways to manipulate the tiles please refer to
Chapter 22, Software Functions

23.5. Save the Project

Save Project allows the chart to be saved as a chart and a collection of
tiles (and any markers) so it can be loaded for editing at a later date. The user
is prompted for a file name, with the file type being XML.
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23.6. Exporting the completed mosaic as an image
Charts can either be exported whole or areas can be selected and saved. To
export the entire image simply select Export as Image from the Files
menu. This will then display a dialog prompting for the desired location and
name of the file. This output image will have an associated world file so it can
be imported into other software packages with the geo-referencing intact.

Note

If there is an area selected on the chart, clicking Export as
Image will only save what is contained within the selection region.
The format of the saved chart will depend on the format of the input
chart (i.e., a .bmp input will generate a .bmp output).

To create an output image using the Selection Tool follow these steps:

First click on the Image Export Area button: 

Using the left mouse button click and hold anywhere on the chart and then
drag the cursor across the screen to create a selection area.

Click on the Files menu and go to Export as Image. Enter a filename
and select the desired file type (.jpeg, .bmp or .tiff) then click Save. A world
file will be created with the same filename as the image file.

Note

There will also be a .kmz file created. This is a Google Earth file
format and will allow the image to be viewed in Google Earth.
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Selection area within dotted line  Output image

Note

It is also possible to output just the tiles (i.e., without the background
chart) by clicking on the Save Mosaic button: 
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24. Supported File Formats

24.1. For Loading Tiles
In order to correctly position the images each image tile file should be
accompanied by an equivalent "world file" which contains positional data. This
data should come from a GPS linked into Seanet Pro. If a GPS is available
Seanet Pro will automatically create a world file with the correct data when
a Snapshot is taken.

The following file formats are supported:

Image Type World File
.bmp .bpw
.jpeg/.jpg .jgw
.tiff/.tif .tfw
.png .pgw

Note

The image file and world file should have the same filename (i.e.,
sonar.bmp and sonar.bpw).

Note

The image tiles have to be saved from the latest version of Seanet
Pro; if an older version is used they will not open in the Sonar
Image Tiler. If in doubt, remove the current version of Seanet
Pro and either download the latest version from www.tritech.co.uk
or re-install from the CD-ROM which contained the Image Tiler
installation program.

24.2. Saving Images or Mosaics
Saving an image can either be the whole chart (with any visible tiles or
markers), a marked out section or a mosaic of tiles either way the supported
formats are:

.bmp Bitmap image

.kmz Google Earth format

.png Portable Network Graphic
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Note

The Sonar Image Tiler will automatically create at matching world
file for the saved image.

24.3. Project Files
The Sonar Image Tiler uses a customised XML format for saving and loading
projects. These project files will preserve any tile data or marker data so
that they can be manipulated again at a later stage or transferred to another
computer for editing.

Note

Due to the fact that the project files contain the data for all the tiles,
if the project has many tiles it can result in the production of large
XML files.

24.4. Marker Files
Two different marker file types are supported both of which are in CSV format
but with different filename extensions and different complexity:

.mrk Seanet Pro full length marker files.

.csv A shortened version of the Seanet Pro format.

Note

For full details of the marker file formats please see Appendix H,
Marker Files.
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Part VII

Maintenance
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25. During Regular Use

25.1. After each use of the equipment
Make sure that after using the sonar head that it is washed down with fresh
water and check the unit for any signs of obvious damage.

Pay particular attention to the transducer head and free any organic matter
which has become trapped. Once the unit is clean; dry thoroughly and place
in the storage container.

If the optional MicronNav Transponder is fitted to the top of the Hammerhead
tripod it should be removed from its mounting bracket and both the bracket
and the Transponder should be washed thoroughly with fresh water prior to
being dried and stowed.

The tripod is made out of stainless steel which will corrode if left in prolonged
contact with salt water so it is essential to wash the tripod thoroughly with
fresh water and make sure it is completely dry (the tripod is free-flooding so
it is advisable to flush fresh water through the pole sections). When drying
attention should be given to any places where moisture is likely to collect,
such as the joins between leg sections.

25.2. Regular maintenance
There are no user serviceable parts inside the Hammerhead Sonar, Interface
Box or MicronNav System and it is not necessary to take them apart for any
maintenance tasks.

The tripod should be inspected for any signs of corrosion and the threaded
sections of the legs should be treated on a regular basis with an appropriate
grease.

The cable on the reel is jacketed with polyurethane and is resistant to
corrosion but a regular inspection routine should be established to ensure
that the length of cable does not contain any damage (which may occur if
snagged or caught on underwater debris).

If the system is in regular use, or submerged routinely for extended periods,
it is advisable to arrange for an annual service to be carried out by Tritech
International Ltd. This service will enable the equipment to be checked
thoroughly or for any worn parts to be replaced and will enable long-term
trouble free operation of the SeaKing Site Survey System. For details of
the servicing options available contact Tritech International Ltd (see Help &
Support for contact details).
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26. Storage of Equipment
If storing the equipment for extended periods make sure that it is completely
dry (if necessary leave to air-dry before stowing).

Pack into storage containers along with several pouches of silica gel. The
original packing containers contain specific foam cut-outs for the storage of
the equipment so wherever possible they should be re-used. The foam will
absorb moisture so if the cases are allowed to get wet they should be dried
thoroughly prior to stowing equipment in them.

Attention should be given to drying the tripod which is free-flooding so will
likely contain moisture inside the steel tubing.

The cable is jacketed with polyurethane which is resistant to corrosion but if
it is intended to store the reel for an extended period without use then it is
advisable to un-reel the cable and dry its entire length. This will also give the
opportunity to inspect the cable for any damage which has occurred during
use.
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Troubleshooting
The following table outlines some problems which can readily be fixed by
altering settings or other simple procedures. If any of these solutions do not
solve the problem please contact Tritech International Ltd using the contact
details listed in Help & Support at the start of this manual.

No World File created by Seanet Pro
Likely caused by a lack of GPS/USBL data.

If using a GPS/USBL ensure that they are connected and set up properly

Check the Installation page to make sure that the correct positioning
device is being selected, or that Fixed Position is selected.

Snapshot captures entire Seanet Pro screen
Incorrect registry setting.

Modify the Windows registry using regedit.exe to ensure that the following
setting is applied:

HKEY_CURRENT_USER\Software\System Technologies\SeaNet\ScrnCapSonarOnly = 1

Sonar scan is sluggish or stops moving, but
communication link is fine

Entanglement of head with debris, ropes, weeds, etc.

1. Turn off power to the sonar to prevent motor damage

2. Retrieve the tripod or ROV, free the sonar head and examine for any
obvious signs of damage

3. Test in air before redeployment

Image appears stretched, distorted or of low range
Hammerhead not sitting level.
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1. Check the attitude sensor reading to determine how level the sonar head is

2. Lift tripod or re-orientate ROV to ensure correct placement and levelling
of the sonar

3. If necessary move to a new location to clear any debris or uneven features
of the sea-bed

Continuous "No Comms" message displayed on the
Seanet Pro status bar

Communication failure or cable failure.

1. Check power is turned on

2. Check cabling from Hammerhead Interface Box to the PC

3. Ensure power is reaching the unit by checking LED's are lit

4. Retrieve sonar from water and ensure that all cabling is correctly installed
and has no splits or ruptures - if necessary remove cable from waterblock
to check for water ingress (also check any blanked waterblocks)

Sonar display does not show compass or attitude
control and shows many types of device options
under Applications menu

The Seanet Pro software in use is the generic version or a previously installed
version (i.e. not the one included on the Hammerhead installer CD-ROM)

1. Launch regedit.exe from the Windows Start menu

2. Navigate to the System Technologies tab found under Software

3. Locate the Seanet tag and alter the CmdLine so that it contains the value
-H

4. Restart Seanet Pro and connect to the Hammerhead device

5. The compass can also be displayed or hidden by right-clicking the main
sonar screen and selecting Auxiliary Compass
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No Internal Compass Heading/Pitch/Roll data is being
displayed

Auxiliary Compass not selected or wrong compass selected in Sonar
Tools menu, Installation page.

1. Right-click on the sonar display and select Auxiliary Compass

2. Navigate to the Installation page from the Sonar Tools menu and
select Internal/Aux Compass. Note that the Ship/USBL Compass
will display data from any connected MicronNav system or from an external
compass string received through a surface COM Port as configured in
Utilities menu and Com Setup

3. If the above steps do not correct the problem close Seanet Pro and
open the Seanet Setup application. The Hammerhead device should
be detected and listed as Node 2. To access the setup for this click on
Action and then Setup to check that the compass settings are correct.

Displaying the output from more than one sonar on
the Seanet Pro screen

Installation of the Seanet Pro application from the Hammerhead CD-ROM will
result in it loading into a special mode where it only displays one sonar by
default - shown in the Applications menu as Single Sonar

1. To display other Tritech International Ltd devices such as MicronNav,
Profiler, Bathy, Gemini or Video it will be necessary to create new display
applications. This is achieved by selecting Application Wizard from
the Applications menu and follow the step-by-step instructions.

2. Other Seanet Pro compatible devices can be brought into Seanet Pro
through another communications link or they can be connected onto the
same ARCNET network. The Hammerhead will have to be configured
manually for networking with ARCNET and instructions can be found in
the Appendices.

3. Other device data from 3rd parties such as GPS, Compass, Altitude can
be input through a surface COM Port. From the Utilities menu select
Com Setup to configure COM ports for these inputs.
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No head is detected in the Seanet Setup application
when running the Hammerhead with the Hammerhead
Interface Box

Data cable or power supply problem

1. Check for either red or green LED's illuminated behind the viewport area
on the Hammerhead. If no LED is illuminated check the power cables are
correctly plugged in and are not damaged. Also check the cables between
the Interface Box and PC/laptop. Make sure that the Power button is turned
on.

2. If the LED's are illuminated first check the USB cable is securely connected
and then make sure that the correct COM port is selected by navigating to
Utilities and Com Setup.

No head is detected in Seanet Setup when running the
Hammerhead on an ROV and connected to an SCU
using ARCNET communications

Insufficient power or incorrect communications settings

1. First check that the red or green LED is illuminated and if not remove the
Hammerhead from the ROV and test on a short test lead. If the unit powers
up on a short lead, check the ROV cabling and that it can output at least
30W at 24V. Also make sure that there is only a single yellow waterblock
in use.

2. If power is reaching the unit then make sure the communications are set
up properly. Ensure that Seanet V2 or newer is installed on the SCU.
Make sure that the termination resistors and ARCNET network are set-up
properly (see the Appendices for the correct procedure).



SeaKing Site Survey System

0672-SOM-00001, Issue 07 104 © Tritech International Ltd.

Appendix A. Example System
Configurations

The Hammerhead unit is equally suited for use either on an ROV or deployed
over the side of a vessel or harbour using a tripod to sit on the sea floor. Since
the unit is based on existing Tritech International Ltd SeaKing technology it is
relatively straightforward to integrate into existing systems or create a mixed
system. A couple of examples are presented here.

Laptop running
Seanet Pro

GPS,
Hammerhead Hub
MicronNav Hub

MicronNav
Transponder

Hammerhead
Sonar

MicronNav
Dunking
Transducer

GPS

Boat equipped with Seanet SCU MicronNav Dunking
Transducer

Hammerhead Sonar

Super SeaPrince 
or SeaKing Sonar

Tritech Subsea 
Junction Box 
inside ROV to link 
Sonar devices

MicronNav Transponder
ROV Communications umbilical
including Sonar data signals

Note

It may be necessary to use a separate power supply if the auxiliary
sonar is rated to a different power rating.
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Appendix B. Assembly of Hammerhead
Tripod

Step 1 - take the two half-shells and assemble them over the top of the
Hammerhead.

Step 2 - Place the gimbal ring over the half-shells, rotate until the screw holes
are lined up then insert screws - note the location of the plastic washer.

Step 3 - Next take the tripod and assemble the legs, screwing them into the
top plate - note that the hook eyes are aligned so the clip can secure both
together.
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Step 4 - Raise the tripod hook and open the Hammerhead securing lugs as
shown, then insert the Hammerhead up through the top plate, rotate and rest
in place before fastening the securing lugs.

Step 5 - Finally connect the cable and route as shown to prevent any
snagging.
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Appendix C. Interface Box Installation and
Operation

The Interface Box should be installed as follows:

• Install the Seanet Pro software from the Hammerhead Installation CD-ROM

• Plug in the USB lead from the computer to the Interface Box, it will be
detected and automatically installed and a new COM port should appear
on the computer. Launch Seanet Pro and ensure that this COM port is
correctly configured and selected for use with the Hammerhead.

• Plug in the power supply for the interface box and turn the unit on.

• Monitor the LEDs on the Interface Box to confirm power and
communications are normal, the sonar should start displaying in Seanet
Pro in a few moments.

!
Warning

If operating on 240V AC mains supply (or equivalent from a
generator) the Interface Box must not be exposed to water.

For reference, a copy of the label printed on the bottom of the Interface Box
is shown below:
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Appendix D. CHIRP Signal Processing
There are several advantages of Tritech International Ltd Digital Sonar
Technology (DST) which allows the use of CHIRP signal processing
technology in order to improve the images generated by the sonar.

In monotonic (single frequency burst) sonar, the range resolution is
determined by the length of the transmitted pulse. The smaller the pulse is, the
greater the resolution achievable and vice-versa. The smallest pulse length
is typically 50 micro seconds and velocity of sound in water is approximately
1500 metres/second which gives a range resolution of 37.5mm. This result
effectively determines the ability to resolve separate targets.

T1

T2

Combined echo
(seen by the receiver)

Target 2 echo

Target 1 echo

Transmitted Pulse

Sonar range
resolution

Target
seperation

Time

Target
Seperation

Using the example above, if two targets are less than 37.5mm apart then they
cannot be distinguished from each other. The net effect is that the system will
display a single large target, rather than multiple smaller targets.

CHIRP signal processing overcomes these limitations by sweeping the
frequency within the burst over a broad range of frequencies throughout
the duration of transmission pulse. This creates a signature acoustic pulse
- the sonar knows what was transmitted and when. Using pattern-matching
technology, it can now look for its own unique signature being echoed back
from targets.

Transmitted signal

Transmitter
circuit

Receiver
circuit

Received decoded signal

pulse duration

In a CHIRP system, the critical factor determining range resolution is now the
bandwidth of the CHIRP pulse which means the range resolution is given by:

Range resolution =
velocity of sound

2 x bandwidth
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The bandwidth of a typical Tritech International Ltd CHIRP system is 50kHz

With velocity of sound in water of 1500m/s this gives a new range resolution
of 15mm.

This time, when two acoustic echoes overlap, the signature CHIRP pulses
do not merge into a single return. The frequency at each point of the pulse is
different, and the sonar is able to resolve the two targets independently.

T1

T2

Combined echo

Target 2 echo

Target 1 echo

Transmitted Pulse

Sonar range
resolution

Target
seperation

Time

Target
Seperation

Both targets
are visible.

The response from the pattern-matching algorithms in the sonar means that
the length of the acoustic pulse no longer affects the amplitude of the echo
on the sonar display.

Longer transmissions (and operating ranges) can be achieved without a loss
in range resolution.

Additionally CHIRP offers improvements in background noise rejection, as
the sonar is only looking for a swept frequency echo, and removes random
noise or out-of-band noise.
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Appendix E. ARCNET Termination
Depending on the cable length the ARCNET communication link requires
a termination resistor to be installed at each end of the umbilical cable.
Normally this is supplied fitted within the ARCNET cable DA-15 or within the
SCU/SeaHub at the surface and is left for the user to fit at the sub-sea end in
a convenient junction box or by use of a special waterblock.

The purpose of these terminations is to attenuate any electrical interference
or "reflections" which may occur due to an impedance mis-match and the
overall aim is to improve signal quality and negate any effects which might
otherwise be felt by other sources of impedance such as from the cable itself.

The diagram below shows best practice to use when installing termination
resistors on an ARCNET network of Tritech International Ltd sonar products.

Note

A special yellow waterblock is available from Tritech International
Ltd which contains an in-line impedance of 39Ω which will enable
quick and easy installation of the subsea termination resistor.

waterblock connectors
Earth (cable screen / pin 6)

RS232 ground (green / pin 5)

-ve DC (black / pin 4)

+ve DC (red / pin 3)

ARCNET B (blue / pin 2)

ARCNET A (yellow / pin 1)

surface unit

surface
termination
resistor

subsea
termination

resistor

Cable length Termination Baud rate setting
Less than 100m Single 39Ω subsea resistor Normal baud rate
100-1200m 270Ω at surface and 39Ω subsea Normal baud rate
1200-2500m 270Ω at surface and 39Ω subsea Half baud rate

Note

If there is more than one sensor connected then the sub-sea
resistor should be fitted at the junction box or splice of the cable.
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Appendix F. Networking and
communication

Overview

The sonar units fitted with the AutoComms feature enable automatic
connection of a single sonar device to a computer without the need to dis-
assemble the unit in any way. The sonar scans available comm settings until
it finds an active one (the one which is connected to the computer). Once an
active one has been found it will set its communication protocols to the correct
settings to enable communication with the PC. The AutoComms feature does
not work for networked devices though and instead the following procedure
should be adopted to allow communication between the sonar heads and
surface PC.

The basic procedure is:

1. Set the communication protocols of the surface unit to match the sonar (i.e.
if the sonar is communicating on RS232, set the surface unit to RS232)

2. Turn off AutoComms (if present)

3. Change the sonar settings to meet new requirements of the system - at
which point it will "disappear" from the computer

4. Repeat for all the sonar devices to be connected

5. Change the surface unit to match the new system settings

Manually Setting Comms

Note

Unless it has been specified differently at time of purchase the
factory default settings of all Tritech International Ltd sonars are
RS232 serial at 115200 baud so if AutoComms has previously been
disabled these settings could be tried first.

1. Set Surface Unit to Match Sonar

Launch the SeaNet Pro Setup application and then select the Setup option
from the Action column.
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A warning should appear to show that the settings are going to be changed,
acknowledge this and then select the appropriate setting from the dialog
box which presents itself. The example below shows the setting for port C
of a SeaHub being changed to RS232 from RS485.

2. Set Sonar to New Setting

The sonar and SeaHub should both show a Status of OK and have green
status colour. Once they are both in this condition select the Setup action
for the sonar but this time click on the sonar which will then bring up the
Digital Sonar Setup screen:
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First make sure that the Disable AutoComms option is checked
and then change the Comms Mode settings in the bottom right
corner. If working on an ARCNET network the baud rates should
be changed by clicking on Baud Rates (in the bottom left of the
above screenshot). Serial baud rates are set up using the Channel
Setup screen which is accessed by returning to the main setup
screen and navigating to Com Setup from the Utilities menu:

3. Repeat the above procedures for all sonar devices which are going to be
on the network.
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4. Set the surface control box to match the new communication protocols of
the networked sonars.

Hard Reset
To perform a "hard reset" and force the sonar back to factory settings first
turn it off and then put a strong magnet over the case in the location indicated
below. Power the unit up with the magnet held in place and factory settings
should be restored.

SeaKing and Hammerhead
Measure 55mm from casing

edge in-line with puller

SeaPrince sonar head
Place magnet over the

mark on the casing
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Appendix G. V6 COM PCB Reset
In the unlikely event that communication to a SeaKing becomes impossible,
units fitted with a V6 COM PCB can be reset to a pre-determined standard
using the magnetic reset function

The default values that will be applied to the SeaKing unit for the magnetic
reset are as follows:

Item changed Default value Item changed Default value
Main Port Comms RS232 Aux Port Comms RS232

Main Port Baud (Hi/Lo) 115200 / 9600 Aux Port Baud (Hi/Lo) 9600 / 9600

Main Port Parity (Hi/Lo) None Aux Port Parity (Hi/Lo) None

Main Port Data-bits (Hi/
Lo)

8 Aux Port Data-bits (Hi/
Lo)

8

ARCNET Baud (Hi/Lo) 156 / 78 Half-Duplex False

ARCNET Sens (Hi/Lo) Neutral Aux. Comms rate 1000ms

ARCNET Timeout 11 [Normal] (ET3) Disable AutoComms True

 COMV6 Fitted True

Main setup changes Baud rate changes

Within the standard SeaKing accessory kit there is a strong magnet supplied
specifically for this purpose.
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Note

The magnet supplied within the accessory kit has a very strong
magnetic field. Due care should be taken to ensure that it is not
placed or left to devices that can be damaged due to exposure to
this type of field, i.e. Harddrives.

To use the magnetic reset, place the SeaKing unit onto a short test lead
connected to an appropriate surface control unit, such as a SCUv5 or
SeaHub, running Seanet Pro with the Setup application.

Note
The port being used by the SeaKing unit should be set to RS232
communications at 115200 Baud.

With the SeaKing unit powered down, place the magnet onto the body tube of
the head approximately 55mm from the end of the connector endcap locking
ring and in line with the endcap puller.

Apply power to the unit and wait for the device to be detected by Seanet Pro.
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Once detected, remove the magnet from the body tube of the SeaKing unit
and safely store.

The unit can now be re-configured to the desired communications. Please
refer to the Arcnet and Serial Communications Manual - 0374-SOM-00003
for more information, or contact Tritech International Ltd.
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Appendix H. Marker Files
Seanet Pro includes the facility to lay a series of markers to label and track
objects, points of interest and way positions. These markers can be saved to
file for the purpose to re-load at a later date, to form part of a report or for use
with the Sonar Image Tiler program.

There are two formats of marker file:

1. A full, comma separated file format with the filename extension .mrk

2. A shortened, comma separated format with the filename extension .csv

Full Marker File Format (.mrk extension)

This is the format that is native to Seanet Pro and includes full details of the
marker configuration. The file is in an ASCII Comma Separated format and
contains the following fields:
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Index Value Description
1 ID This is a unique string ID. It comprises a 2 letter header

("mk") followed by a DateTime code. Any unique string value
is acceptable.

2 Group This is unused and should be set to 0.
3 X Coordinate For the .mrk file this will always be output in UTM Easting.
4 Y Coordinate For the .mrk file this will always be output in UTM Northing.
5 Altitude This is UTM Altitude and is currently unused.
6 UTM Zone Parallel Zone latitudinal letter (e.g. 'C' through 'X').
7 UTM Zone Meridian Zone longitudinal number (e.g 1 through 60).
8 UTM Ellipsoid Ellipsoid code (0 = Airy, 1 = Australian National, 2 =

Bessel1841, 3 = Clarke 1866, 4 = Clarke 1880, 5 = Everest, 6 =
GRS80, 7 = International 1924, 8 = Modified Airy, 9 = WGS84).

9 Point Size Applies to Circle, Square & Triangle shape types only,
otherwise set to 0.

10 Date & Time Date & Time in English(GB) Locale.
Format is "dd/mm/yyyy hh:mm:ss"

11 Shape Type 0 = Circle, 1 = Square, 2 = Triangle, 3 = Sonar Range, 4 =
Preset Image (see Image Info below).

12 Shape Colour Applies to Circle, Square and Triangle shape types only,
otherwise set to 00000000 (32 bit RGBA).

13 Font Inner Colour Applies to Comment Text (32 bit RGBA).
14 Font Outer Colour Applies to Comment Text (32 bit RGBA).
15 Marker Bitwise Bit 1 = Show Marker, Bit 2 = Show Coordinates, Bit 3 = Show

Comment Text (i.e. 00000111 = Show All).
16 Image Info Presets = Red Flag, Blue Flag, Green Flag, Buoy, Anchor,

Rock, Danger, POI, ViewPort, Sonar, Diver, Wheel, Comment
or MLO
Alternatively can be full path and name of an image file (e.g.
'C:\Image1.bmp').

17 Comment Comment text.

For example, the following two markers would produce a two line .mrk file
as shown:
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mk41149.5595988657,0,548699.614997778,6313221.96999907,-5.3544902067987E-76,V,30,9,0,
   28/08/2012 13:25:51,4,00000000,00FFFFFF,00000000,7,Red Flag,Possible Wreck Site
mk41149.5605201736,0,548724.213265236,6313198.87994614,-5.3544902067987E-76,V,30,9,0,
   28/08/2012 13:27:48,4,00000000,00FFFFFF,00000000,7,Rock,WARNING! ROCKS

Shortened Marker File Format (.csv extension)
This file format is a more concise and usable format, particularly for loading
a pre-defined target list into Seanet Pro. The file is in an ASCII Comma
Separated format and contains the following fields:

Index Value Description
1 ID This is a unique string ID. It comprises a 2 letter header

("mk") followed by a DateTime code. Any unique string value
is acceptable.

3 X Coordinate For the .csv file, will be in coordinate system used in Seanet
(either Longitude or UTM Easting).

4 Y Coordinate For the .csv file, will be in coordinate system used in Seanet
(either Latitude or UTM Northing).

17 Comment Comment text.
11 Shape Type 0 = Circle, 1 = Square, 2 = Triangle, 3 = Sonar Range, 4 =

Preset Image (see Image Info below).
16 Image Info Presets = Red Flag, Blue Flag, Green Flag, Buoy, Anchor,

Rock, Danger, POI, ViewPort, Sonar, Diver, Wheel, Comment
or MLO
Alternatively can be full path and name of an image file (e.g.
'C:\Image1.bmp').

10 Date & Time Date & Time in English(GB) Locale.
Format is "dd/mm/yyyy hh:mm:ss"
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For example, the following two markers would produce a two line .csv file as
shown:

mk41149.5595988657,-2.1991799999203,56.9600300036883,Possible Wreck Site,4,Red Flag,
   28/08/2012 13:25:51
mk41149.5605201736,-2.19877999992026,56.9598200036882,WARNING! ROCKS,4,Rock,
   28/08/2012 13:27:48
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Glossary
.bmp The standard filename extension for bitmap images.

.kml The standard filename extension for a Keyhole Markup
Language file which contains georeferencing data. This file
will either be incorporated within a .kmz file or requires an
accompanying image file (with the same file name) to be
valid. Used by Google Earth.

.kmz The standard filename extension for a compressed file
containing the Keyhole Markup Language file (.kml) and
image file. For storing georeferencing data and images in
a single file. Used by Google Earth.

.mrk The standard filename extension for marker files exported
from Seanet Pro, saved as a text file in tabular format with
table cells separated by commas.

.png The standard filename extension for Portable Network
Graphics - a bitmapped image format employing lossless
compression.

.tiff or .tif The standard filename extension for Tagged Image File
Format.

AC Alternating Current

AIF Originally "Acoustic Interface" but also used to refer to
"ARCNET Interface" in which case it can refer to either the
interface port on a SeaHub or SCU or to the expansion card
available for installation into a computer.

ARCNET Attached Resource Computer NETwork - a network
protocol similar to Ethernet but with the advantage of
working over much longer ranges.

ASCII American Standard Code for Information Interchange - a
character encoding scheme originally based on the English
alphabet.

AutoComms Hardware developed by Tritech International Ltd for use
in sonar heads which enables the sonar to automatically
switch to the correct communication protocol to match that
of the surface controller.

CD-ROM Compact Disc - Read Only Memory

COM Short for "communications". When used in the context
of computers typically it refers to the Microsoft Windows
designation of a serial communications port (in this
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instance it may be given a number, "COM3", for example).
In the context of sonar hardware it can be used to refer
to the circuit board that controls the communication to the
surface.

CSV Comma Separated Value - a text file in tabular format
with table cells separated by commas, usually given the
filename extension .csv but this can vary depending on
the application.

DA-15 A 15 pin D shaped connector used mainly for the ARCNET
connection on the SCU and SeaHub.

DC Direct Current

Google Earth A virtual globe, map and geographical information
program, originally called EarthViewer 3D prior to being
acquired by Google Inc. in 2004.

GPS Global Positioning System.

Hammerhead A survey sonar produced by Tritech International Ltd and
part of the SeaKing range. Capable of producing very high
resolution sonar images which can then be loaded into the
Sonar Image Tiler software as part of a site survey.

JPEG or JPG Joint Photographics Expert Group - a compression method
and file format for image files, files can be stored with either
.jpeg or .jpg file extensions

Kevlar Poly-paraphenylene terephthalamide high strength, light
weight, material branded and sold as Kevlar by DuPont.

LAN Local Area Network

LED Light Emitting Diode

MicronNav An Ultra Short Baseline (USBL) system for location and
tracking of ROVs, divers, etc. Consists of the MicronNav
100 surface control unit (similar to the SeaHub but with
different functionality) a "dunking transducer" which is
mounted on the vessel/dockside under the waterline and a
responder which is mounted on the ROV or Hammerhead
tripod.

PA500 An altimeter sold by Tritech International Ltd

PC Personal Computer

RAT Remote Access Terminal - the detachable front part of the
Tritech Surface Control Unit (SCU) computer. Provides an
alternative to using a keyboard and mouse.
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ROV Remotely Operated Vehicle

RS232 Traditional name for a series of standards for serial binary
data control signals.

RS485 A standard for defining the electrical characteristics of
drivers and receivers for use in a balanced digital multipoint
system (also known as EIA-485).

RX Receive (data)

SCU Surface Control Unit - a specially manufactured computer
which is rack mountable and capable of processing the
data from the sonar equipment running either Windows
XP Embedded or Windows 7 and Seanet Pro or Gemini
software.

SeaHub An alternative to using a Seanet SCU, this device connects
to a laptop or PC via USB interface, essentially this takes
the signal from the sonar (in RS232, RS485 or ARCNET)
and converts it into a signal suitable for the USB port of the
computer.

SeaKing A specific sonar produced by Tritech International Ltd but
also refers to the family of sonar equipment manufactured
by Tritech International Ltd comprising of the SeaKing,
SeaKing DST scanning and profiling sonars and the
Hammerhead survey sonar.

Seanet Pro The software supplied by Tritech International Ltd which is
capable of running all the sonar devices.

Sonar Image Tiler The application developed by Tritech International Ltd to
allow georeferenced sonar images to be joined together
and placed on a chart as a mosaic.

Tritech waterblock The 4000m depth rated connector developed by Tritech
International Ltd for their subsea equipment.

TX Transmit (data)

USB Universal Serial Bus.

UTM Universal Transverse Mercator coordinate system - a 2-
dimensional Cartesian coordinate system to give locations
on the surface of the Earth.

WGS84 World Geodetic System (1984 revision) - a standard for use
in cartography, geodesy and navigation and used as the
reference coordinate system by GPS devices.
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world file A file used by the Tritech Sonar Image Tiler program
which is designed to accompany an image file and contains
geo-referencing data. The file format will have different
extensions depending on the format of the image file:

Image type World file
extension

.bmp .bpw

.jpg or .jpeg .jgw

.tif or .tiff .tfw

.png .pgw

XML Extensible Markup Language. A markup language and file
format that is designed to be both human and machine
readable.
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